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Introduction

Welcome to Family Tree, the program that allows you to build a lasting history of your

ancestors and descendants by creating trees that really come to life!

With Family Tree you can produce all manner of records and certificates both quickly and

easily. All the necessary tools for classifying and sorting your genealogical data are
contained right here.

With this program you will be able to:

Create records of your family members and establish the relationships between them.
Create certificates for birth, christening, marriage, death and burial events.

Attach multimedia sounds and pictures to your family members, and view or print them just
like a family photo album.

Tell the story of family life throughout the years using a unique time line display of your
pictures.

View and print tree diagrams illustrating ascending and descending relationships.

Gain valuable insight into your family history with statistics of the evolving population, life
expectancy, marriages and births.

Import and export your data in GEDCOM file format.

Browse the content of example trees, which will help illustrate the full functionality of the
program.

In order to make the most efficient use of Family Tree and its many features you must be

familiar with the basics of Windows. Please refer to your Windows documentation for more
information.
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2 : Family Tree Program Basics

Family Tree Program Basics

Files

The family tree information that you enter into this program will be stored in a file. If you have
information for different unrelated families, then be advised to record this in separate files.

You can have as many files as you like for different families, but only one can be opened and
edited at a time. Additional files can be created using the New option, but this is only
possible when there are no files already open. Once you've created a new tree file you must
save it to your hard disc and assign it a filename using the Save As option.

When you are regularly updating a file with new information, always save it at frequent
intervals to you avoid losing important data.

The Display
When you start the program you will be presented with the Family Tree program window. If
this is the first time you’ve used the program, an example file will be opened automatically to
illustrate what you can achieve using the program. Once you create your own file, this will be
opened for you instead.

124 GSP Family Tree [_TO]x]

Across the top of the window you'll see a menu bar and directly below it a series of buttons
running along a toolbar. At the other end of the window is a taskbar with five oval shaped
buttons on it. Between these three areas of the screen you can access all the tools needed to
build and research your family tree. You can also use keyboard shortcuts, which are simply
combinations of keys pressed in sequence to achieve the same result.

You'll soon discover that the buttons on the toolbar change accordingly with the options you
plan to use. As a first example, the options to be able to open or create a new file will only
be available to you when a file is not already open. Therefore in order to create a new file
you must first close the one currently open.

Throughout this manual you'll notice highlighted areas just like that shown below. These show
you all the different ways of selecting an option, which you may want to try out as you
become more familiar with the program.
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Example :
+
X . =
Open File File | Open Ctrl+ O Y
Function Access: Menu Option Shortcut Button

Once a file has been created or opened, other windows will start to appear inside the main
application window. Each window will allow you to do different things with your family
information including creating tree diagrams and analysing statistics. Each of these actions
will be explained in more detail later on in the manual.

On-line Help

Help Help | Index F1 ﬂ

The information in this manual is also available in a shorten form through on-line help. If you
need specific information about how to do something, simply select Help | Index and
choose the required task.

If you need help finding out what a button does, place your cursor on it and wait for a few
seconds. During this time the button may animate to illustrate it's purpose after which a pop-
up hint will appear to tell you what it does.

About Family Tree Help | About... g

To discover information about the program and where to obtain technical support, if required,
select Help | About. Click anywhere on the dialog that appears to remove it.

Family Tree Windows

As previously mentioned, Family Tree presents different information about your family data
in separate windows. Technically speaking this is achieved using MDI - Multiple Document
Interface. This means that you are can have several different views of a family tree file at the
same time (each appearing in a separate window).

Program Window

When only the Family Tree program window is open you have use of the following options.
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4 : Family Tree Program Basics

Within this window there are five types of other windows that can appear. These are outlined
below, and will be described in more detail later on.

Main View window

The Main View window is the first to appear when you create or open a family tree file. Its
purpose is to simply indicate that a file is open and to present a pictorial view of your family
through images associated with individuals in the file.

Tree of Descendants window

This window displays a tree of descendants. Prior to displaying this window you will be asked
to select the person who is to be the head of the tree. All this person’s descendants will then
be shown in a treelike structure in a new window. Repeating this process will create more
windows.

When a tree of Descendants window is active the toolbar contains the same buttons as when
the Main View window is active, with the addition of the following buttons:
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Tree of Ascendants window

This window displays a tree of ascendants. Prior to displaying this window you will be asked
to select the person who is to be the bottom of the tree. All this person’s ancestors will then be
shown in a treelike structure in a new window. Repeating this process will create more
windows.

When a tree of ascendants window is active the toolbar contains the same buttons as when
the tree of descendants window:

Family Album window
This window displays a Family Album containing photos extracted from a family tree. You may
have more than one Family Album window shown at once.

When a Family Album window is active the toolbar contains the same buttons as when the
Main View window is active, but with a Print button.

Statistics window

This window displays a set of family statistics for the current tree. You may have more than one
Statistics window shown at once.
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6 : Family Tree Program Basics

When a Statistics window is active the toolbar contains the same buttons as when the Main
View window is active, but with a Print button.

Print File | Print Ctrl + P

¥

Filter R

Handling Multiple Windows

When you have several or all of the above-mentioned windows open the following
instructions will prove useful:

To select a single window from many, simply click anywhere on it's visible area. This will
bring the window to the front, placing it on top of the others. Alternatively, select it from the
Windows menu, or if you have more than 9 windows open, the list provided using the More
Windows option.

The top line of the active window shows you which family tree you are working with, along
with the type of window (eg. EG_TREET.GFT - Main View). If a window is maximised this
information is displayed in the title bar of the program itself within square brackets (eg. Family
Tree - [EG_TREE].GFT - Main View])

To switch between windows, pressing Ctrl + Tab will move to the next window in sequence;
Shift + Ctrl + Tab will move to the previous window in sequence.

To close a window double-click on its system menu or press Ctrl + F4.

The following window commands are available whenever a family tree is open:

Cascade windows Window | Cascade
Arrange the windows so they are all the same size and overlapping one another. This allows
you quick access to all your windows.

Tile windows Window | Tile Horizontally
Arrange windows one above another. If there are too many windows open then the windows
will be tiled in a grid. This allows you to compare different statistics displays easily.

Tile windows Window | Tile Vertically
Arrange windows one alongside another. If there are too many windows open then the
windows will be tiled in a grid. This allows you to compare different tree displays easily.

Arrange icons Window | Arrange Icons
Arranges any windows that have been minimised to icons along the bottom of the screen.

Dates

Dates are entered in the format dd/mm/yyyy, ie. You must specify the year in full. If you just
enter the last two digits of the year, eg. 67 instead of 1967, then you are specifying dates in
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the 1st century. Specifying dates from the year 2000 onwards will cause problems if you use
the abbreviated form!

If an actual date is unknown you may enter just a month and year: eg. 7/1967 specifies July
1967.

If you are even more uncertain on a date then you may enter just a year: eg. 1967.

Accented Characters

Accented characters can be entered into all appropriate fields using the standard Windows
keystrokes: ie. ALT followed by numbers on the numeric keypad (NUM lock must be ON). A
look up table of useful characters can be found towards the back of this manual.

Note that first letters that are accented will appear at the bottom of any sorted lists. Eg.
Edward, Egbert and Frank will appear in the order:

Edward
Frank
Egbert
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8 : Starting From Other Family Tree Products

Starting From Other Family Tree Products

Data can be imported from other family tree products by using a similar process to that
detailed above. Export your family tree in GEDCOM format from your existing application,
open that file in Family Tree and save as a .GFT file.

See the GEDCOM section for more details.
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Starting From Scratch

Before you can begin building your family tree you must create a new file. To do this, close
any open files and click on the New button. This will create an empty file and present you
with the Main View window complete with an empty picture frame.

Close a open tree File | Close

Create a new tree File | New Cirl + N —

Before entering information into the tree, supply your details, as the author of the tree, using
the File Information option in the File menu. This displays a dialog box in which you can
type your name, address and tree name. Once you've done this click on the OK button.
You're now ready to begin building your family tree.

First decide which person you wish to start the tree with. Unless you have in-depth knowledge
of all your ancestors it may be wise to start with yourself and your immediate family. Once
you've decided, select the Edit/New Individual option from the Taskbar.

Edit/Create Individuals Edit | Edit Individuals

This will present a dialog box, which will eventually list the names of all the individuals in your
family tree. Since you've not yet created any individual records, the only option available to
you is ‘Create New Individual’. Double click on this entry to open a new individual record.
Information about creating records can be found in the Individuals section of this manual.

As a general rule the quickest way to build a tree is to follow the family bloodline, travelling as
far as possible from your descendants to your ancestors and vice versa. When there are
either no more in known existence or they're yet to be discovered, you can begin to expand
the tree by introducing each member of their immediate family. The links possible between
these individuals are to Fathers, Mothers, Sons, Daughters, Wives and Husbands. Always
attempt to connect families a generation at a time before moving into any extended family
members. This will help prevent the loss of important links.

With only a very simple record structure you can begin to view tree diagrams of your
descendants and ascendants and quickly discover the people you need to investigate next. If
you've been thorough about your work and have attached pictures to your records, these will
also appear in the trees if you so choose.

As you create your individual records, always try to supply dates of important events such as
births and deaths. These are used to calculate statistics about your family and their evolution,
which can be analysed using the ‘Statistics’ option.

Finally, as a way of discovering more about the life of your family and its individual members,
you can browse through the programs family photo album and even examine a timeline of
their historical events.

The important thing to remember when building your family tree is that its not just about seeing
how far your family goes back in history but what you can learn about them on the way there.
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Tracing Your Family History

Outline

Family Tree is designed to help you keep track of your family tree; however, as a starting
point you must research and gather this information together. This section will give you some
pointers on how to proceed with this.

The starting point is easy, start with yourself:

e  When were you born?

o  Where were you born?

e If you're married, when and where were you married?

e You may have copies (or can get copies) of your birth certificate

® You will have a copy of your wedding certificate (if you're married).

Once you have this information, you can gather together similar information for your spouse,
any children you may have, your (and your spouse’s) parents and your grandparents.

Try to keep together your information on each individual. Always take copies of any relevant
certificates and make notes on where you got the information (ie Family Bible; verbally from
uncle John or the General Register Office). Enter your information into Family Tree as and
when you obtain it, you don’t have to have a complete record on an individual before you
add him/her to your tree.

Collecting together photographs for you and your close family should be quite easy; scan
them in and keep them in one directory on your PC. Again, keep a track of where they came
from - and backup your PC regularly in case you have a hardware failure!

We have included a form at the back of the manual in which you can record the basic
information you need for each individual. Feel free to photocopy it and take it along on your
research trips. Alternatively, open up the Help Contfents page and go to the Printable
Information Sheet. You can print this from within the Windows Help system.

Talk to your parents, and grandparents (if possible), and make careful notes of any details
they can give you about your relatives. Write down the information you learn and add fo it as
you go along (with birth dates, wedding dates, etc). Always try to check the information you
receive through alternative sources - you don’t want to unknowingly accept rumours as fact!
Ask for copies of birth, marriage and death certificates if they’re available.

Family Tree



Tracing Your Family History : 11

Continue contacting near relatives, explaining what you are doing and trying to widen your
knowledge of your family tree. Remember to ask if anyone has done something similar - you
might save yourself a lot of work!

As your information gathering spreads and reaches further back in time, you will find a
number of organisations who can help you:

o Indexes for birth, marriage and death certificates are held by the General Register Office
(address at back of manual). Their records reach from 1837 onwards. You will need to
pay for duplicate certificates, and you can apply for these by post. The quality of the
information held has improved as time goes on (eg only from 1911 did birth indexes show
the Mother’s maiden name).

e A more localised source of information, reaching back further in time, are local Parish
Records. These are a very valuable source of information, but their records can be patchy
during certain periods in history.

e Wills also contain some valuable information - Somerset House holds details of people
who have died leaving no will, wills where the executor was deceased and standard wills
after 1858. Will information prior to 1858 is available from the Public Record Office.

e The Family History Centres of the Mormons allow you access to the International
Genealogical Index, containing details of baptisms and marriages gathered together from
parish registers. From here you should be able to find birth, marriage and death certificate
information.

¢ Information on people sharing dwellings can be obtained from the Public Record Office
(address at back of manual). Information such as first name, last name, place of birth etc of
the people living at a given address can be found. These records are held from 1801
onwards at 10 yearly intervals; although recent census data is not available until it is 100
years old.

e For international research, a copy of the International Genealogy Index (IGl) can be seen
at any of the Mormon Family History Centres. Alternatively, a postal service is available
from Family Tree Services (see back of manual for details).

The list of potential information sources is endless, and to help you in your search you may
want to subscribe to a genealogy magazine, such as Family Tree Magazine (details at back
of manual) to give you hints, tips and inspiration! Additionally, you can enlist the help of a
professional researcher: check the Association of Genealogists and Record Agents for a list of
professional researchers.

Tutorial

So you've glanced through the manual, loaded the program; and now you'd like to start
entering your data. This guide will walk you through the basic steps and help you get a 'hands
on' feel of the program - by starting to create your own Family Tree.
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12 : Tracing Your Family History

Begin by closing any open files and use the mouse to click on the New File button (top left
button as you look at the screen). The window that then appears presents an empty picture
frame to indicate a file is now open and ready to work with. No pictures will appear until
such time as you create individual records and associate pictures with them.

As the author of any tree files you choose to create, you should always supply your details as
a point of reference for future generations who may wish to continue building the tree and
perhaps expand different branches elsewhere in the world. To do this, select File Information
from the File menu. A dialog will then appear in which you can supply the name of tree as
well as your name and address. Once you've done this click on the OK button.

To save information on your computer, and ensure you don't lose any by mistake, use the
mouse fo select Save As from the File menu. Once a file has been saved it will be opened
automatically for you next time you use the program.

With Family Tree you can create as many files as you like but you can only work on one file

at a time. Therefore in order to be able to open another file you must close the one you're
currently working on.

Here is a list of names, and some information about them, that we shall put into your sample
tree:

I TN T T 2020

Roland Ewart Johnson 1902 1954 Grandfather
Margaret Hall Johnson 1905 1977 Grandmother
(nee Henderson)
Thomas White Johnson 27/08/1922 Father
Catherine Lilian Johnson 29/01/1924 Mother
(nee Reid)
Pauline Elisabeth Howard 31/10/1947 Daughter
(nee Johnson)
Heather Johnson 06/05/1952 Daughter

Start your sample tree with information about the father, Thomas White Johnson by clicking on
the Edit/Create an Individual bution on the Family Tree taskbar. Select Create a new
individual by double-clicking on those words, and an individual dialog screen will come up on
the screen. Fill in Thomas's surname, then his first names separated by spaces. Now click on
the button next to the "birth" box. A small dialog box will come up on the screen for you to fill
in details about his birth (enter date as 22/7/1922), time and place of birth. This same
procedure is used for his christening or death, for which there is no information, so leave them
blank. Then click on the male/female symbol to make sure he is recorded as male (this
alternates each time you click on it). You have now completed your first individual record.
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To link up the remaining relations, first click on the Relations button at the bottom of
Thomas's individual record screen. Confirm that you want to keep the information you've just
entered by clicking on OK. You will be presented with a list of relations that you may like to
enter - initially there won't be any of these! As we want to enter the mother's details next, and
she is the wife of Thomas White Johnson, double-click on Connect a new wife. Once more we
are presented with a choice of likely relatives - choose Create a new wife by double-clicking
on those words. The individual dialog box will appear for you to enter Catherine's details
(Catherine Lilian Reid). Enter her maiden name as her surname (ie Reid) as ALL females
MUST be recorded that way, and then all her remaining details in the same way as entering
Thomas's details. This record will automatically be shown with a "female" symbol, because it's
been selected as a "female" (ie wife) relation.

Again, we want to link in other relations, so click on the "Relations" button. This time, Thomas
White Johnson is shown as an existing relation, ie a husband, as it is Catherine's individual
record that we're working on at this time. To move up the family tree to Thomas White
Johnson's father (ie the grandfather) double<click on Thomas's name in this relations list. This
will take us back to Thomas's individual record so that we can enter his father's (the
grandfather's) details. You can do this by one of two methods: clicking on the button inside
the Father box or again going fo the Relations button.  With either route, we are able to
choose Connect a new father - ie Thomas's father (Roland Ewart Johnson). Again an
individual dialogue box appears, only this time it already has the surname filled in for us. You
can then fill in the remainder of Roland's details.

To enter the grandmother (Margaret Hall Henderson), go to the relations box shown in the
Roland's individual record (the finder dialog screen now shows Thomas recorded as an
Existing son, which proves the link between father and son had been made) and choose
Connect a new wife (the grandmother, Margaret). The list will show you other female's (ie
Catherine's) names as 'possible’ wives, but we want to select a 'new' wife for Roland, so
doubleclick on Create a new wife. Enter Margaret's details in the new individual record,
again using her maiden name as her surname.

On looking in Margaret's "Relations" box, she is related to Roland (shown as her husband),
but not Thomas her son (since he could have been somebody else's child), so we have to
make a link between them. We do not want a "new" son, as Thomas' details are already
recorded. Go to the relations box and choose Connect a new son. The list will show you all
possible (likely and unlikely!) sons. Double click on Thomas to complete this connection. You
will now be shown Thomas' record.

Now add the two daughters to your tree. To create the first daughter's record (Pauline
Elisabeth Johnson), click on the "Relations" button. You will be shown Thomas's existing
relations, and the "new" relations list, from which you choose "connect a new daughter". A
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short list of "possible" daughters will be shown but we need a "new" daughter. Once again
an individual's dialogue box will appear. This time, however, it already has the daughter's
father (Thomas) and surname (her maiden name of Johnson) shown in their relevant "father"
and "surname" boxes. Now enter the remainder of Pauline's details. Again, on looking in the
"Relations” listing from her record, her mother is not shown. We do not want a "new" mother
created, as her mother (Catherine) already exists. In this case let's Cancel the "Relations"
listing and Pauline's individual record will return to the screen. Click on the button in the
"mother" box, and you will be presented with a list of "possible" mothers from which you can
choose her mother's (Catherine's) record. This creates the link between mother and daughter.

To enter the second daughter's record (Heather Johnson), go back to Thomas's record and
chose a "relation" - another "new" daughter. (Brothers or sisters are not options as relations
and are entered as a child of a parent). Again, the surname (maiden name) and father's
details are already entered and you can fill in the remainder. (We could have chosen to
create Heather's details from her mother's record, but the details of surname and father would
not have automatically been entered, and the link to her father would still need to be made.)
With the knowledge gained from entering Pauline's details, go to the "mother" box as the last
detail of Heather's individual record, and click on the button in this box. You can choose
Catherine from the listing to make the mother/daughter link and so complete your sample
family tree.

To see what this tree looks like, close the current individual record. The main functions of
Family Tree will again be shown on the screen. Click on the "Descending Tree" and choose
Roland Johnson's name from the list of individuals, as he is the individual that we want to show
as the top of the tree. The screen then shows a "Tree" with the grandfather, and his wife; the
father below him, along with his wife (the mother); and the two sisters at the bottom of the tree.
This can now be printed out.

Alternatively, you can click on Ascending Tree and use Heather as the base of the tree. This
would show Heather, her father and mother, and her grandparents, although it would not
show her sister Pauline, as Pauline is of the same generation as Heather and not in ascending
line. This can also be printed out.

You are now ready to start your own family tree file using these basic steps. Your own tree
can grow and grow as you get further information on relatives; add pictures, photographs or
sounds; and create your Family Album.

We hope you enjoy using GSP's Family Tree.
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GEDCOM

GEDCOM is a standardised file format for swapping files between different family tree
programs.

Import
To import a file, use the open command.
Open an existing tree File | Open... Cirl + O

In the List files of type: drop-down, select All Files (*.*). Use the File Open dialog fo select
the GEDCOM file you wish to load and click on OK. To save your file in native Family Tree
format use the Save As option to save the file. Remember to change the extension of the file
you save to .GFT. If you just use the Save option, the file will be saved as a GEDCOM file
again. GEDCOM files will not store extra formatting information added by Family Tree, such
as photos and certificates.

The GEDCOM standard is a vastly complicated and extensible specification which has been
used (and abused!) by many family tree products in many ways. However, it will allow you to
transfer your family tree structure into this program and out to other programs. Extra features
offered by this program, such as photographs, are not a necessary part of the GEDCOM
standard and you will have to use the .GFT format to keep such information.

If there are any problems during the import of a GEDCOM file you will be given a warning,
and the file GEDERR.TXT will be created in the same directory as your GEDCOM file. If you
have encountered problems you might be able to use a word processor to adjust the original
.GED file and then re-import, eg. Dates that are badly formatted must be reformatted in the
proper way. Bad date entries in the GEDCOM file are given a 'zero' date as a placeholder
within the tree. Entries such as CIRCA 1867, 1867/1868, ABOUT 1867 are not valid.
Having imported a GEDCOM file you may wish to use the File Information option from the
Main View window in order to set the title and author information correctly.

Export
Export as GEDCOM File | Export as GEDCOM...
To export a file in GEDCOM file format, select the export as GEDCOM command.

Select a file name to save the GEDCOM file as and click on OK. An exported GEDCOM file
does not retain its photographs, certificates, tree styles etc.
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Individuals

Family trees are based around individuals and the information you know about them. In
creating your family tree you will create new individuals and store their dates of birth, dates of
death within the program. All the basic information is contained on one dialog within the
program, with further information accessible indirectly from that dialog.

Edit/Create Individual Edit | Edit Individual

Using this command shows the Finder Dialog.

by

“|Everyone ﬂ Select an individual ta
F o= Cregte new indivicial —

F = Brown, Jasming Alice (27 Jul 1992 -3

F = Brown, Liam Meil (7 Jan 19945-)

F & Brown, Meil John {11 Mov 1968 - )

2 Evetts, Josie (6.Jul1925- 15 Dec 19497)

F = Johnson, Abigail Francesca (4 Sep 1996 - )

F = Johnson, Alexandra Helen (30 Mow 1994 -3

F & Johnson, Alice (31 Jul 1972 -3

F & Johnson, Jeffery Andresw (23 May 1970-)

F & Johnson, Tom (5 Sep 1930-)

F oz Jones, Albert (1 Jan 1801 - 20 Aug 1965)

F ¥ Jones, Alison (1.Jan1938-)

- Jones, Andrea (3 Jun 1997 -) S HMew Ij
F % Jones, Andrew (4 May 1970-) i B

L % Jones, Andrew (1 Apr1921 - 5 Jan 1992) e Fier... |
% Jones, Brian Johnathan (1 Jan 1933-) izl

F E Jones, Carol Gweneth (9 Sep 1963 -7

The Finder Dialog is used extensively throughout Family Tree to locate, select and create

individuals. The dialog lists all individuals’ names that you have entered into the program so
far; and can be viewed in different ways by double clicking on the folder at the top of the list.

You can select an individual to edit or Create New Individual by clicking on the relevant entry
and then clicking on OK, or by double clicking directly on the entry.

If you right click on an entry within the tree you are shown a pop-up menu with some options
included on it:

Edit Person Name: Shows you the selected person's information. Using this option allows you
to move quickly around the tree. This is the same action as selecting the person and clicking

on OK.

Delete: Deletes the person from the tree.
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Basic information

When you select an individual, or create a new one, you will see a dialog containing
information about that individual.

| Lastame flores - .'_:-'Edili.ﬁéliHi'sro'L;r'. :

- FistNaes [ober o |
CEm e e

.:'-._E:Ihlis‘ten'i.t;g,Wé'. ﬂ I

ath 20 Aug 985

: S?H;"“.-'

| Prafession |Carpenter

2 5 l'.__.f.'-‘é*t'lsmith&JDnBSJDi”BW Sk F'rlnt | Mew | |

A e

- Multimedia Objects. .. | Certificates... | Relations. . | Rezearch... | Cloze I

Changing any of this information and clicking on Close will show you a message box asking
you if you would like to save the changes you have made. Select Yes to do so, or No to
cancel changes you have made to that individual.

Last, First Names: store the name for the individual.

NOTE: If a person has several names, you should type them in the First Names area
separated by spaces.

Birth, Christening, Death: these show the date of the relevant event. By clicking on the small
button to the right of each field you can enter/edit details of the date, time and place of each
event.

NOTE: Dates are entered in the format dd/mm/yyyy, ie. You must specify the year in full. If
you just enter the last two digits of the year, eg. 67 instead of 1967, then you are specifying
dates in the 1st century. Specifying dates from the year 2000 onwards will cause problems if
you keep using the abbreviated form!

Sex: indicates the sex of the person. Click on the picture shown next to the field to toggle the
sex male to female, then female to male.

Profession, At: store details of what the person does for a living and where.
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Notes: is a free format field, which allows you to store other pieces of textual information
about an individual. You might want to include information here about how individuals were
named, where they grew up etc.

Father/Mother

The Father and Mother fields show the first and last names of an individual’s father and
mother. Clicking on the small buttons to the right of each field will either show you the details
for the father/mother (if previously entered), or show the Finder Dialog if one hasn't.

‘|Possible Parents |Select a person to be

A A the Father of Jones,
Likely choices Albert,

L . Creste 3 Now Father
Unlikely choices

2 Brown, Meil Jahn {11 Moy 1968 -}
& Johnson, Tom {5 Sep 1930-)
2 White, Patrick John (5 Way 1958 -3
%= White, Stewart (1 Jan 1982 -)

5 Fi-Iter.. |
ﬂ_l T e - Sden i L ﬂ Cancel |

You may select an existing person to be the parent or you may create a new individual who
will then be linked up as a parent of the current individual. If you make a mistake and need to
change a father or mother, use the Disconnect function in the Relations dialog to break the

link.

: .':: : Mew |

Relations...

The Relations button allows you to make connections between individuals in your family tree
or to move quickly to individuals that you have already connected.

Clicking on this button displays the Finder dialog containing entries for all the relations that
you have entered for the current individual, along with entries that allow you to connect further
individuals.
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To show an existing relation’s information click on the relevant person and then on OK, or just

double click on the entry.

To connect new mother, father, daughter, son, husband or wife, click on the entries displayed
under the New folder. This will replace the contents of the Finder dialog with a list of possible

parents, children or partners.
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Here you may select an existing person to connect to or create a new person already
connected to the current individual. The way you use this dialog will vary according to the
way you work: some people prefer to create all the individuals in the tree and then connect
them together, others will prefer to create the connected individuals as they go along.

NOTE: You may connect to multiple wives; allowing for people who have been married more
than once. The order in which the marriages are displayed is determined by the date order of
the marriage certificates. If the same people are married together more than once then this
information must be recorded by creating multiple marriage certificates for those people.

NOTE: If you are connecting a parent to a child, the program cannot make the assumption
that the parent's partner is also the parent of the child. For example, if person A and B are
married, and you edit a son specifying his father as person A, the Mother field for the Son is
not automatically filled in with person B. This is to allow for single parent families, and children
born to people who have been married more than once (allowing you to connect a
son/daughter to the relevant mother).

When you right click on an entry in the Finder dialog a pop-up menu will appear possibly
offering the following options:

Connect New Relation: Connect a new daughter, son etc..

Edit Person Name: Shows you the selected person's information. Using this option allows you
to move quickly around the tree.

Disconnect: Allows a relationship to be disconnected. The two people's records will still exist,
but the link between them will be broken.

NOTE: If you disconnect a person, their children may also have to be disconnected within the
tree.

Multimedia Objects

You may wish to add photographs and sounds to the individuals within your tree. The pictures
will appear in the trees of ascendants and descendants, and the Family Album window.
Pictures and sounds are accessed through the Multimedia Objects... button. Clicking on
this button will show the Multimedia Objects dialog.

Bfoiyse Myit'imedizi Objects

Multimedia Objects

_' War Service Photograph

Add | =
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On the left are listed the names of the multimedia objects linked to the current individual.

On the right is a preview of the currently selected image. If you have added a sound, a small
picture of a speaker will appear: double click on the speaker to play the sound file.

To add an image, click on the Add... button.

Multimedia Object
File Narre : i il .. ”Erowsa.. ..
I'_ e S s
Date | S
Notes B
- H

For every object you add you may enter various pieces of information:

Event: The name of the event depicted within the photo/sound. You'll discover in the Family
Album that you can filter pictures based on the name of a specfic event. Therefore you may
like to try and use a standard set of key words within this text box.

Date: The date of the event depicted in the photo/sound. In the family album the photos are
ordered according fo this date; so if you don’t know an exact date it is worth trying to enter a
rough one to keep your photos displayed in a better order.

NOTE: Dates are entered in the format dd/mm/yyyy, ie. You must specify the year in full. If
you just enter the last two digits of the year, eg. 67 instead of 1967, then you are specifying
dates in the 1st century. Specifying dates from the year 2000 onwards will cause problems if
you use the abbreviated form!

Notes: This is an area where you can enter some general information about the photo/sound.
Try not to write too much information; it is shown below the photos in the family album, and a
large amount of text tends to detract from the look of the album (you can of course turn the
printing of notes off within the family album!)

File Name: This contains the full path to the photo/sound that you wish to place in the album.
The easiest way of adding a photo/sound is to use the Browse... button to show the
standard Windows open dialog. Use this to find the photo/sound that you wish to enter into
the family tree. Use the List files of type: drop-down to show image or sound file formats
allowed.

Photos can be added to your family tree using the following image formats.

Bitmap (.BMP), JPEG (.JPG), FlashPix (.FPX), Photo CD (.PCD) and ZSoft Paintbrush (.PCX)
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NOTE: If you intend using bitmap images, ensure your files do not use the RLE encoded sub-
format.

Whenever you attach a photo, the program records the location where the image file resides
on your hard disc. Images are not embedded inside your family tree file so make sure you
don’t delete or move them by mistake.

Depending on the display settings of your computer, images and other graphics will appear
with varying colour depth and detail. The various icons, buttons and other graphics
associated with this program are designed to appear using a palette of 256 different colours.
Settings higher than this such as high or true colour are also permitted and may prove more
useful if you plan to use photos in your tree files. For more information about display settings
please refer to your Windows documentation or Help system.

When using photos, try to restrict their file size as much as possible. Their dimensions and the
number of colours they use govern this. Large images will consume more space on your hard
disc and will affect the performance of the program and printing. Always consider purpose
and appearance of the images within the program and adjust their size and quality
accordingly.

As a general rule, images destine to appear within tree diagrams should be rectangular in
shape and typically 200 x 150 pixels in size. The orientation is entirely up to you but
obviously choose one that best suits the subject - i.e. group or single portrait photo. Images
to be viewed in the Family Album can be bigger if the subject requires more detail.

In addition to the physical pixel size of your images you should also consider their colour
depth. Using high or true colour display settings will allow images to appear on screen and
be saved with a palette of thousands of different colours. The result of this is that a much
larger file is created. However, with appropriate graphics software you can easily edit the
size and colour of your photos.

You may click on entries within the list of multimedia objects with the right mouse button to
show a pop-up menu allowing you to perform various operations:

Edit: Allows you to change the event name, date, notes and the photo/sound file. This is done
in the same way as creating a new object.

Delete: Removes reference to this multimedia object from the family tree. This does NOT
remove the photo or sound file from your computers hard disc!

NOTE: This command will be unavailable if a Family Album window is open (check in Browse

Windows).

Show/Don’t Show in... [Tree/Album]: Using these two options you can finetune the
appearance of your tree diagrams and family photo album by excluding specific images. This
can prove useful if you have several pictures associated with a particular individual or simply
have pictures without dates that you would like discarded. To toggle between these two
settings simply click on the relevant option.
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Regardless of these seftings, it's also possible to temporarily hide all pictures from your tree
diagrams by selecting Don’t Show Picture from the View menu.

Getting photos onto your computer:

If you're not familiar with using digital cameras and scanners they’re the quickest and easiest
way fo get images onto your computer. Scanners are ideal for copying those old
photographs you've taken or were handed by past generations. Cameras on the other hand
are perfect for capturing and reviewing instantly the latest family events as they happen.

Once you have these images why not share them with your family by email, if you have it,
and if they do the same you'll find you can soon accumulate quite a collection of images for
your tree.

If you do have either a scanner or a digital camera don’t worry. Most film developers offer a
service where by images from negatives can be processed and stored on a special format
Photo-CD that can be read by most CD-ROM drives. The Photo-CD format actually offers a
choice of settings enabling you to choose smaller size/number of colours to ensure you don't
fill up your computer's hard disk!

The images on these CD's are generally very large in terms of file size but their special format
permits you to specify image settings for size and quality.

Getting sounds onto your computer:

Transferring sound recordings onto your computer may prove a little more difficult than your
photos. You will need access to the original recording from a device with a special sound
output (a Line Out, as offered by many video and cassette recorders) and a sound card with
input facilities (with a Line In, as offered by most sound cards). Connect the two together and
use the software that comes with your sound card, or the Sound Recorder application that
comes with Windows, to 'capture' the recording into a .WAV file. You will have to adjust your
recording settings and try a few samples to make sure the recording is loud enough and yet
not distorted. Unless you want top quality recordings, choose settings to give you the lowest
possible file size. This stops your hard disk filling up rapidly (sound recordings can occupy a
surprising amount of space), and makes access to the sounds quicker. Try using settings such
as 11kHz 8 bit Mono.

Certificates

Certificates allow you to store extra information about individuals within your family tree.
These include Birth, Christening, Civil Marriage, Religious Marriage, Death and Burial
certificates.

Clicking on the certificates button displays the certificates dialog.
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This lists all the certificates that currently exist or which can be created for an individual.

The Birth, Christening, Death and Burial certificates behave simply as information containers:
you can choose to fill them in or not.

From these dialogs further ones are accessible which allow the entry of further information for
relevant individuals at that time, e.g. the occupation, age and notes on the Father at the time
of the birth certificate.

Civil and Religious marriage certificates, however, can only be created for any individuals that
have been connected as wives/husbands within the tree. It is therefore possible to have more
than one marriage certificate listed for one person, and you may even have more than one
marriage between two individuals. You may also delete a marriage certificate: right click on its
entry in the certificates dialog and select Delete.

NOTE: The ages on the certificates are the ages at the time of the events; not the current age
of that individual.

The certificates have been designed for printing on A4 paper in landscape orientation. This
will be automatically set by the program, provided the default setting is left on ‘Portrait’. If
certificates start to appear different than expected, please check your printer settings.

Research

Research, as its name suggests, allows you to keep records of sources you've discovered,
tasks to be completed and related documents you've scanned for a specific individual. For
more information about this particular feature please turn to relevant section in this manual.

Printing
Clicking on the Print button allows you printout a form containing all the information currently

known about the selected individual. These forms can then be collated for the family members
you're investigating and be taken with you to the places you plan to research their past.

You can choose to print these forms in bulk using the Print Forms option in the File menu.
Selecting this option will allow you to print single blank forms, forms for everyone in the
current tree diagram or forms for everyone in the tree file.
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Research

In order to help you investigate your family, a research feature has been included in the
program, which will allow you to keep records for sources you've discovered, tasks to be
completed, and related documents you've scanned for specific individuals.

There are a couple of different ways you can find this feature.
o Click on the Research button within a specific individual’s record.
o Select the Research... option from the File menu.

The difference between these two approaches is that one lists the notes for a specific
individual, whilst the other lists notes for everyone in the tree.

Selecting either of these options will present you with the dialog shown below.

- '.Rescércthbte_s_&-S_(')_u'rc.es .

Research Notes & Sources

Jones, Albert, Investigate possihility of invalvement in World War |,
Jones, Albert, Investinate possibility of earlier ife.,
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{% Jones, Albert, Post card from India - what's was he doing there?,

Delete |
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Listed are the record entries for all research notes so far entered. There are three different
types of record each one represented by different icon.

%4 i

Tasks to do. Sources to investigate. Documents scanned.

These can be filtered by clicking on the different Show references at the bottom of the dialog.
If you've opened the Research feature from an individual’s records, an extra reference will
appear restricting the records to only the current individual. Removing the tick against this
reference will list all the records currently available.

Handling Record Entries

To add an entry to the list, click on the Add... button. This will display a small pop-up menu
offering you three choices - Source, To Do and Scanned documents. Select the desired
option and an appropriate record dialog will appear in which you can supply the details.
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You're permitted to enter a fitle describing the entry plus any additional notes you feel are
necessary to fully understand it. Once you've supplied these, click on the OK button.

If you're adding an entry for a scanned document you can choose either to browse the hard
disc for an image already created or launch your scanners dedicated software and scan a
completely new document.

Record entries can be deleted at any time by highlighting them within the list and clicking on
the Delete button. Confirmation will be given before the entry is permanently removed.

Printing Record Entries

Record entries can be printed out and taken with you on your visits o investigate family
history. Using the Print and Print Selected buttons you can choose either to print the
details of all the current entries or a single entry, which you must select first.

To print all the record entries currently available click the Print button. To print a single entry,
select it from the list using your mouse pointer and click on the Print Selected button.
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Tree Displays

One of the main purposes of gathering together your family tree data is to enable you to
produce tree diagrams showing all the connections between members of your family. Two
ways of doing this are included in this program.

Tree of Ascendants

Tree of Descendants

A tree of descendants traces the descendants of a particular person: showing all sons and
daughters for that person, and their sons and daughters in turn etfc.

A tree of ascendancy traces the ancestors of a particular person: showing the mother and
father of a given person, and their mother and father and so on.

Clicking on the Tree of Descendants or Tree of Ascendants area on the Family Tree Taskbar
will display the Finder Dialog.

Use this dialog to select the person whose descendants or ascendants you wish to view. These
will then appear in a new window. You can look at different trees in different windows at the
same time if you desire.

Display Modes

Tree diagrams can be viewed in two different modes; these are ‘Research’ and “Print Preview'.
The difference between them is that one enables you to view your tree diagram, as it will
appear on paper - if you print it. The other will display only the basic tree structure. In the
‘Print Preview’ mode you can customise the trees appearance by adding borders, changing
fonts and colours and using backgrounds. Choose the mode which best suits how you want
to view the tree and for what purpose it'll be used.

Tools

Depending on the mode your tree diagram is displayed in, there are different tools you can
use fo view it. Some of these are duplicated on both the toolbar and menubar, whilst others
can be found on right-click popup menus. As your files and tree diagrams expand you may
want to experiment with these.

Tree Detective

This tool is very useful in quickly telling you the relationship between any two individuals in the
tree. Simply select an individual, place the pointer over another and in a few seconds a hint
will appear informing you of their relationship.
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Zooming

Large tree diagrams can’t always be viewed clearly at certain sizes. Often information
becomes very small and too illegible to read. For this reason it is possible to increase the view
of the tree and examine specific branches and individuals in more detail.

There are several methods of doing this, which have their different uses and advantages.

Zoom In View | Zoom In
Zoom Out View | Zoom Out

Once up close, if you want to quickly see the entire diagram again, select ‘View Entire Tree’
from the right-click pop-up menu.

Rather than magnifying the diagram one step at a time you can also use the ‘Zoom’ tool.

Zoom Tool

Clicking on this presents a small preview of the entire tree, in which you click and draw frames
around the areas you wish to examine. The dialog in which the preview appears can be
moved anywhere on the screen by clicking and dragging it there.

Record Editing

In both the Research and Print Preview modes you can edit and create records for your family
tree. If you double click on an individual within the tree, their details will be shown. You can
then make changes and save them if you want. If you double click on a blank area of the
tree, an empty individual details dialog appears for you to create a new person.

Pop-up Menu
Depending on the mode your tree is displayed in and the position of your pointer, pressing
your right mouse button will present a pop-up menu of different options. These include:

Edit: Allows you to edit the information held on this individual.

Delete: Removes this individual from the tree. Removing an individual will break links in the
tree.

Hide Sub-Tree: A subtree can be described as a branch of the tree showing a single
individual and any descending/ascending individuals connected to them. Selecting this
option will remove these individuals from the diagram and replace them with a symbol to
indicate their hidden presence. To show these individuals again right click on the sub-ree
symbol and select Show Sub-Tree. Hiding a sub+ree isn't a permanent action; it's unique to
the current diagram and will not be saved as a setting with the tree file. This function is mainly
used fo restrict the size of a tree before printing it. Symbols representing hidden sub-rees will
not appear in any printouts you produce.

Edit Default Style/Create Individual Style: These options are only available when you are
viewing your tree diagrams in Print Preview mode. Styles are used to let you personalise the
look of your tree and its appearance on screen and in printouts. Using these options you can
add borders and backgrounds, change text and information and save these settings in unique

styles.
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Styles
Family Tree can customise the way in which trees are displayed in a number of different ways.

All'individuals appearing in a tree use the settings of the default style. Changing the default
style changes all individuals in the tree; (although there are separate options within the default
style for males and females). By right clicking on an individual in the tree and selecting Create
Individual Style, a different set of styling options can be created for one individual. Having
created an individual style you can then use Edit Individual Style to change it, or Delete
Individual Style to return it to the default style.

NOTE: Although styles can be saved, whom these styles are applied to cannot; because
multiple tree views can be made on an overlapping set of individuals. Setting individual styles
is therefore best used for highlighting key individuals prior to printing, rather than customising
every individual in a treel

The tree style dialog offers you a number of options.
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The top right of the dialog shows previews of how male and female members of the tree will
appear. You'll notice there’s a frame around one of these to indicate which one will be
affected by any changes you make. To swap between male and female members, click on
the appropriate preview. With a gender selected the following setftings can be changed.

Events: The events check boxes refer to both Male and Female entries:

e No Events shows just an individual and their partner’s names.
e Short Events shows name, date of birth and date of death.
e Long Events shows name, date & place of birth, and date & place of death.

Texture File: Use the Browse... button to select a texture to display underneath the tree area.
Select appropriate bitmaps for your display (256 colour or 16 Million colour accordingly).
Several texture files have been supplied with Family Tree, see the section Included With
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The Package for more details. To no longer display the texture (which will give you quicker
performance), select the path that appears within the Texture File edit box and delete it.

Print Texture: Allows you to choose whether the texture you select above appears on printouts
of the tree or not.

Specific to Male/Female: All items grouped within this box apply to male or female entries
only; according to the current selection at the top of the dialog.

e Name Colour/Spouse Name/Other Text Colour: Clicking on the button to the left of
these fields allows the various text colours to be changed. The dialog shown is the
standard Windows colour selector.

e Font: Selects the font to use for all items of text.
e Line Colour: sets the colour of the lines used to connect individuals within a tree.

e Border: Selects the border to place around an individual’s box. Choose from a
selection of borders that we have included in the product, or None to give the
default square box.

e Colour One, Two, Three: The borders have all been designed to allow you to
change the colour elements within them. Clicking on one of these buttons shows the
standard Windows colour selector dialog with the current colour highlighted.

Click on the Apply button to update the tree diagram with the changes specified.
Alternatively, click on the Close button to cancel the changes and leave the tree diagram in it
original style.

The changes you've specified will be saved and used next time you want to create a tree
diagram. If you find you're changing the style of your diagrams on a regular basis you may
like to save them individually. To do this click on the Save button, in the bottom right corner
of the style dialog, and specify a name for the style in the text box provided. You can delete
styles at any time by selecting them from the drop-down list and clicking on the Delete button.

Once you have saved a style you can use it in any tree window (ascendants and
descendants) as a default or an individual style; and at any time in the future.

Printing

In order to print your tree diagrams you must be viewing them in Print Preview mode. This
enables you to view them identically as they’ll eventually appear on paper. In this mode there
are several options, which will allow you to optimise the diagram for printing. These are
available using the right-click pop-up menu.

Fit to one page: As it suggests this option will position the diagram to best fit on a single
page. Bear in mind that depending on the shape of your tree, whether it’s tall or wide, you
should consider changing the orientation of the page to either landscape or portrait.

Fit to current page selection: This option is best used when you've changed the page size and
quantity using the buttons around the virtual page. Selecting this option will automatically
resize the diagram to best fit the pages you‘ve specified.
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Auto paginate: This option takes the difficulty out of quantifying and sizing pages by
automatically defining them for you. This option guarantees the printout will be at optimum
size and easily readable.

Set up border: In addition to placing borders around individuals, you can also add a border
around the edge of the entire tree diagram. This option will help you set one up.

You'll notice in this particular mode of display, a virtual page can be seen beneath the tree
diagram itself. Surrounding this page are three buttons, which act as handles and allow you
to adjust the size and number of pages the diagram will be printed on. To adjust these, click
and drag them in the appropriate direction.

You can also adjust the position of the virtual pages themselves by clicking and dragging them
around inside the window.

Tree Borders

Border: From the Border drop-down list select the design of the border that you want. You will
see a small preview of the border in the top righthand corner of the dialog. Depending on
the complexity of the design you may need to preview it in the tree diagram itself before
making any decisions fo use it.

Colour One, Two, Three: The borders have all been designed to allow you to change the

colour elements within them. Clicking on one of these buttons shows the standard Windows
colour selector dialog with the current colour highlighted.

Header font: Selecting this allows you to change the font style used in the title header and
footer.

Title/Footer: These text areas are printed at the top and bottom of the printout respectively. If
you have printed across several pages they appear in the very middle of your printout: they do
not appear on every page.

Once you're happy with the border and settings you've specified, click on the OK button
otherwise click Cancel.
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Your tree diagram should now be ready to print. Click on the appropriate toolbar button or
select Print from the File menu.
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Family Albums

The Family Album window within Family Tree gathers together photographs from throughout
the family tree and allows them to be printed in the style of a photo album.

® Example. gft - Al

Pictures that have been selected as Don’t Show in Album from an individual’s Multimedia
Obijects dialog will not appear in this window. See the Multimedia Objects section for details
of how to add pictures to your family tree.

All photos are shown in date order from top to bottom on pages running left to right across the
screen. If no dates are given for a photo it will appear on the far left of the album.

Right clicking within this window will show a pop-up menu containing several options:

Layout: selects the number of pictures to display per page.

NOTE: You can change the way a page looks and prints by changing the printer setup
through the File | Print Setup menu entry. Selecting landscape printing for the current
printer can produce a different style. Select the Layout option after having changed the printer
setup in order to update the screen.

NOTE: You are not allowed to delete pictures from the tree if a Family Album window is
open.

Zoom In/Out: shows you more or less detail of the family album. If you resize the family album
window it will rescale the display to fit exactly within the height of the window.
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Browse: shows a dialog similar to the individual’s Multimedia Objects dialog. ALL multimedia
objects are shown in the list fo the left of the dialog; those in bold will appear in the album. By
right clicking on any entry you may select Don’t Show in Album, or edit the entry.

Style: shows a dialog box allowing you to change the way your family album appears.

The Style Dialog allows you to adjust the way your Family Album will appear on screen and
when printed out.
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The various fields that appear on this dialog are as follows:
Page Header: Appears on the top of every page when the time line display is off.

Page Footer: Appears on the bottom of every page when the time line display is off. Placing
&t will place the title of the family tree into the header or footer fields, &p will place the
current page number info the header or footer fields.

Show notes: When this is ticked the notes that have been entered for a multimedia object will
be displayed along with the photo. Click on the tick to turn this off.

Show individuals name: When ticked, the individual’s name to which a photo was attached
will appear underneath that photo.

Show Time Line: When this is ticked (the default) a special time line style is used. This places a
pattern behind the pages of the album with large headers and footers indicating the starting
and ending years of photos on a page. If no years were specified for a photo the header or
footer may appear blank. If there is a change in year on any one page, the background
colour will change to emphasise this. This style gives a clear view of your photos over time.
Fonts: There are three font options to allow you to change the various fonts within areas of the
Family Album display.

Texture File: Use the browse button to select a texture to display underneath the album area.
This will appear behind the time line background if you have that selected. Several texture
files have been supplied with Family Tree, see the section Included With The Package

for more details. To no longer display the texture (which will give you quicker performance),
select the path that appears within the Texture File edit box and delete it.
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Print Texture: Allows you to choose whether the texture you select above appears on any
printed versions of the Family Album.

Match Name/Match Event: The text entered into these fields is matched against the event
description and individual’'s name of every photo; only matching entries are displayed. If you
entered “Wedding” into the event field it would display only wedding photos (eg. “Brian &
Jacqueline’s Wedding”, “Wedding of Mike & Delia”). It is worth bearing this in mind whilst
you enter event descriptions for your photographs. Entering information into the Match Name
field has the same effect on individuals” names.

Having chosen the style of the Family Album and what to include within it, it can be printed
from the Print command.
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Statistics

The Statistics window shows some interesting information gathered from the information you
have entered about your family tree.

¥ Example.glt - Statistics [_ O[]
Statistics for My First Family Tree e o ‘ b
Popuistion Evolution of Population
20
10
19‘00 19‘10 19|20 19|30 19|40 19!50 19{50 19‘70 19‘80 19‘90
Merm=— Women— Totak Date
Aoe Life Expectancy

Mumber of Men: 15

Mumber of Women : 19

Awarage Number of Children: 1.2
Maximum Mumker of Children : 4
Mumber of Multiple Marrizges : 0
1
1

60 - Wazimum Number of Marriages :
ko Humger of Unconected Individuals
40 ; {
20 ki
i
0

Average Man Awerage ¥oman
67.5 Years B0.7 Years

The top part of the window shows the evolution of the population for your family tree: that is
the total number of living individuals at a given time in history.

In the bottom lefthand corner of the window is a graphic depiction of the average life
expectancy of male and female family members. Individuals who have no date of birth or no
date of death given are not taken into account here.

Finally in the bottom right-hand corner of the window are some statistics about the family data
that you have entered.

Number of men, number of women: the total numbers of each sex in your family tree.

Average number of children: this is based on the total number of individuals in the tree. If you
enter one couple with one son into the tree the average number of children per person is 1/3,
or 0.3.

Maximum number of children: the greatest number of children from any individual within the
family tree.

Number of multiple marriages: the number of individuals who have married more than once.

Maximum number of marriages: the greatest number of marriages that any individual has had.
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The statistics can be gathered for the whole tree (the default), or by filtering selected data.
Right clicking within the statistics window shows a pop-up menu with a Filter option in it. Click
on this to enter some text to match against individual’s first and last names. Statistics will be
gathered only for matching individuals, and the title at the top of the window will indicate this.
You can use multiple statistics window to compare information from different sides of your
family etc.

The statistics data can be printed out for reference off line; use Print Setup to select landscape
or portrait printouts.
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Included With The Package

Fonts

Included with the program are 10 classic fonts that will help you perfect the appearance of
your tree diagrams. These fonts are installed together with the program files and copied into
the appropriate Windows folder. If you choose to remove them from your system afterwards,
you can install them again individually from the fonts folder on your Family Tree CD-Rom.
Please see your Windows documentation for details of how to install fonts.

Buckingham ABGDET GHIJabcdefgbij
CasqueOpenFace ABCDEFGHIJabedefghij
Cornet ABCDETGH I febedofihi
GuntherCalligraphic ABCDEFGHLlJabcdefghij
HandStroke ABCDEFGH Tabedefyhy
Manuscript Open ABCHETC T I Inbraefghis
OldEnglish ABCRCE I GIHI Jabedefahij
Penchant ABLEDLESGILIFabedef abij
Ramona ABCDEFGHI Jabedefghij
Scogin ABCDEFGHDabcdefghis
Textures

Included with this program are six custom designed backgrounds for use as textures within
your family tree. These can be found in the Texture folder within the Family Tree install
directory (ie. C:\Program Files\FamTree\Textures by default)

e

CANVAS.BMP DIALOG.BMP PARCH.B

MP
i g%& .»:Q%,}g
\1‘;?“ SEY ‘I
PARCH2.BMP WEAVE.BMP STIPPLED1.BMP STIPPLED2.BMP
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STIPPLED3.BMP ROLLED.BMP TEXTURED 1.BMP TEXTURED2.BMP

CLOUDS.BMP

Examples

When you first start using Family Tree, an example file will be opened automatically for you.
This is designed to illustrate the features of the program and to allow you to experiment with a
fictitious tree before you begin creating your own.

In addition some other examples have been included with the program, which can be loaded
if you wish to view and analyse them. These particular trees relate to The Bible and The British
Royal Family. Although it's unlikely you'll be able to use them as a basis for your own tree’s
they’re great for analysing all the same.
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Hints & Tips

Installation problems: Ensure that you are NOT running any other applications at the
time of installation as these may interfere with the installation process. If you have problems
try temporarily disabling screen savers, toolbars (e.g. MS Office™ toolbar] etc, restarting
Windows and then trying installation again. This program has not been tested with Windows
shell replacements such as ‘Tabworks'.

One of the biggest causes of installation problems is poor machine housekeeping. If you
experience problems please run CHKDSK or SCANDISK and then DEFRAG. See your
Windows documentation for more details.

Backups: Family Tree automatically creates backup files when you save your tree. If you
are working on the file NAME.GFT, the old version of that file will be saved as NAME.BAK.
You can turn this facility off by changing the line Backup=True in the
C\WINDOWS\FTREE.INI file to Backup=False.

Images don't display correctly 1: Check that you are not using bitmaps that have more
colours within them than your screen can handle (eg. True colour images on a 256 colour
screen).

Images don't display correctly 2: Check that you are not using the RLE encoding
format within your BMPs. This format is relatively rare, but seems to cause problems in most
applications!

Can’t do something?: This program makes extensive use of the right mouse button: if you
can’t see how to do something try to right click on entries/windows and you'll often find what
you need appear in a pop-up menu.

Connecting Individuals: If you are connecting a parent to a child, the program does not
make the assumption that the parent's partner is ALSO the parent of the child. For example if
person A and B are married, and you edit a son specifying his father as person A, the Mother
field for the Son is not automatically filled in with person B. This is to allow for single parent
families, and children born to people who have been married more than once (allowing you
to connect the mother as the relevant wifel).

Dates: Dates are entered in the format dd/mm/yyyy, ie. You must specify the year in full. If
you just enter the last two digits of the year, eg. 67 instead of 1967, then you are specifying
dates in the 1st century. Specifying dates from the year 2000 onwards will cause problems if
you use the abbreviated form!

Dates: If an actual date is unknown you may enter just a month and year: eg. 7/1967
specifies July 1967.

Dates: If an actual date is unknown you may enter just a year: eg. 1967.

Default texture: The .BMP file used for the default texture within trees of descendants and
ascendants is set in the FTREE.INI file within the Windows directory. The line starting
Default Texture= defines the location of this background file.
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GEDCOM: Information that you cannot expect to import from a GEDCOM file include
photographs and some certificate information.

GEDCOM: |f dates are not being imported at all for certain fields it could possibly be due to
the way in which the exporting application is presenting that information. For example, dates
stored in the following formats will not be imported: “Before 1967”, “Around 1967". Search
for such dates in the exporting application and replace them with just the year information

“1967".

Hidden Subtrees: Llost the hidden subtrees that you have applied to a tree? This
information is not saved in the tree data (since you may have two or more views of the tree
open simultaneously that you would like to appear different to one another). If you make any
changes to the tree the display must be regenerated from the tree data, thus losing the subtree
information. Hiding subtrees is best used just before printing.

Individual Styles: Lost the individual styles that you have applied to individuals in a tree?
These styles are not saved in the tree data (since you may have two or more views of the tree
open simultaneously that you would like to appear different to one another). If you make any
changes to the tree the display must be regenerated from the tree data, thus losing the
individual style information. Individual styling is best used to highlight key individuals etc.. just
before printing.

Lost your photos?: If you have changed the place where you keep your photos, or have
given a copy of your tree to somebody who has put their tree somewhere else on their hard
disk, then the photos will no longer appear. If the program cannot find the photos you have
given it, it will look in the MM subdirectory of the program. Eg. C:\GSP\FTREE2\MM. You
can therefore gather together all your photos and place them in this directory to fix the
problem.

This second place in which files are looked for is set through the MMLIB line in the FTREE.INI
file within the Windows directory. You may change it as long as it points to a valid path, and
ends in a backslash, eg.

MMLIB=C:\PHOTOS\

Photos: The program stores a reference to where your photographs are; they are not stored
directly within the family tree itself. You should therefore not delete them or move them, or they
will not appear within the tree. You can, however, edit them (eg. To change brightness) using
other applications.

Speed: Family Tree automatically creates backup files when you save your tree; this takes
extra fime. You can turn this facility off by changing the line Backup=True in the
C\WINDOWS\FTREE.IN!I file to Backup=False.

Speed: Want to make your tree displays quicker2 Try turning off the Texture File from within
the default style, and set Draft Mode and Don't Show Pictures from the View menu.

Window Tiling: Tiling windows is best used for viewing several trees of descendants or
ascendants alongside one another. Generate the views you want, minimise the Main View
and then tile the windows horizontally or vertically.
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???: If when you aftempt to run the program a window appears with no buttons along the
toolbar and with a heading of 222, the program cannot find its .INI file. The file FTREE.INI is

placed in the WINDOWS directory during installation. If this has been moved/deleted, you
will need to re-install Family Tree.
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Accented Characters

Accented characters can be entered into all appropriate fields using the standard Windows
keystrokes: ie. ALT followed by numbers on the numeric keypad (NUM lock must be ONJ.

A ALT+0192 a ALT + 0224
A ALT + 0193 4 ALT + 0225
A ALT + 0194 & ALT + 0226
A ALT + 0196 & ALT + 0228
C ALT + 0199 c ALT + 0231
E ALT + 0200 & ALT + 0232
E ALT + 0201 é ALT + 0233
£ ALT + 0202 8 ALT + 0234
E ALT + 0203 é ALT + 0235
| ALT + 0204 i ALT + 0236
i ALT + 0205 i ALT + 0237
i ALT + 0206 i ALT + 0238
i ALT + 0207 i ALT + 0239
) ALT + 0210 o ALT + 0242
©) ALT + 0210 6 ALT + 0243
°) ALT + 0211 5 ALT + 0244
°) ALT + 0212 5 ALT + 0245
©) ALT + 0214 6 ALT + 0246
U ALT + 0217 0 ALT + 0249
U ALT + 0218 i ALT + 0252
0 ALT + 0219 6 ALT + 0250
U ALT + 0220 0 ALT + 0251
Y ALT + 0221 y ALT + 0253

¥ ALT + 0255
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Useful Addresses

You may find the following addresses useful in tracing your ancestry.

Family Tree Magazine

61 Great Whyte, Ramsey, Huntingdon, Cambridgeshire, PE17 THL.
Telephone (01487) 814 050

Birth, Marriage and Death Certificate Enquiries

General Register Office
PO Box 2, Southport, Merseyside, PR8 2JD.
Telephone (01704) 569 824

Professional Research Agencies

Association of Genealogists and Record Agents (AGRA)
29 Badger's Close, Horsham, West Sussex, RH12 5RU.

Census Information

Public Record Office
Ruskin Avenue, Kew, Richmond, Surrey, TW9 4DU.
Telephone (020) 8 876 3444

Will and Last Testament Enquiries

Public Record Office
Somerset House, Strand, London, WC2 TLP.
Telephone (020) 8 876 3444

General Record Information

Metropolitan Archives Greater London Record Office
40 Northampton Road, London, EC1R OHB.
Telephone (020) 7 332 3820

Guildhall Library
Aldermanbury, London, EC2P 2E].
Telephone (020) 7 322 1863
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Specialist Genealogy Library

Society of Genealogists
14 Charterhouse Buildings, Goswell Road, London, ECTM 7BA.
Telephone (020) 7 251 8799
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